# Table of Contents

**Read Me First** .................................................................................................................. 3
  Training and Support Resources ......................................................................................... 3
  UA World Wide Web Policy for Unofficial Websites .......................................................... 3
  UA Logos, Watermarks, and Web Guidelines ...................................................................... 4
  ADA Compliance .................................................................................................................. 4
  Login and Security .............................................................................................................. 5
  Use the Right Web Browser ............................................................................................... 5
  Password Setting ................................................................................................................. 5
  Computer Security ............................................................................................................. 5
  Public URL .......................................................................................................................... 5
  Editors URL ......................................................................................................................... 5

**A Beginner’s Guide – The Basic Steps** ............................................................................. 6
  Adding Text .......................................................................................................................... 6
  Adding Pictures ................................................................................................................... 9

**Alternative Text (Alt Text)** .............................................................................................. 14

**Free Stock Photography** .................................................................................................. 15

**Columns** .......................................................................................................................... 16
  Column widths snap to a grid ............................................................................................... 16
  Move and Copy Columns .................................................................................................... 17
  Delete a Block of Columns .................................................................................................. 17

**Sections** ............................................................................................................................ 18
  Customize Your Backgrounds .............................................................................................. 21
    Video Background ............................................................................................................ 21
    Image Background ........................................................................................................... 23
    Solid Colored Background ............................................................................................... 23

**Create Pages and Arrange Navigation** ........................................................................... 25

**Edit the Header Image** ................................................................................................... 28

**Create a Flexible Header** .................................................................................................. 30

**Blogs** .................................................................................................................................. 32
  Start a Blog ........................................................................................................................ 32
  Create a Blog Post .............................................................................................................. 33
  The Blog Sidebar ................................................................................................................. 36
  Manage Blog Comments ..................................................................................................... 38
  Use Facebook Comments on Your Blog ............................................................................ 40
  Use Disqus Comments on Your Blog ................................................................................ 42
  Schedule a Blog Post .......................................................................................................... 44

**Forms and Surveys** .......................................................................................................... 47
  Create a Basic Contact Form ............................................................................................. 47
  Contact Form Submissions ................................................................................................. 51

**Video, Audio and Other Content** ..................................................................................... 53
  Upload Video ...................................................................................................................... 53
  Using the Audio Player ....................................................................................................... 55
  The YouTube Video Element .............................................................................................. 56
  Embed Video and Audio to Your Site .................................................................................. 57

**The Block Quote Element** ............................................................................................... 59

**Upload PDFs, PowerPoint Slides and other Docs** .............................................................. 60
Read Me First

Training and Support Resources
You can locate and print the most recent version of this manual at our People.ua.edu website, http://people.ua.edu. The core of People.ua.edu is powered by Weebly. You can find their training and videos at http://help.weebly.com/. When referring to their site, you will see references made to both Free and Pro Service accounts. UA has purchased the Pro Service accounts for all our faculty members. However, not all features shown on their support site are available to faculty. The ‘Revenue’ feature may not be used without written permission by University Relations.

Your site will come preloaded with the UA template. Some of the images in this guide are not UA images. Weebly does a great job at explaining their product so we chose to use most of their online guide as-is with a few modifications.

UA World Wide Web Policy for Unofficial Websites
3.0 — Unofficial University Web Sites

1. Unofficial University Web Sites are defined as Web sites or Web pages created by University of Alabama entities including, but not limited to, individual University employees, faculty, staff, students, and student organizations to represent individuals, groups, or organizations.

2. All Unofficial University Web Sites must carry the following disclaimer or similar: "The views, opinions, and conclusions expressed in this page are those of the author or organization and not necessarily those of The University of Alabama or its officers and trustees. The content of this page has not been reviewed or approved by the University of Alabama, and the author or organization is solely responsible for its content." We have added this statement via a link in your site footer.

3. The University of Alabama will not undertake to pre-approve or review the content of Unofficial University Web Sites. However, any pages discovered in violation of this Policy are subject to immediate removal from University of Alabama Web servers.

4. Unofficial University Web Sites may not be used for commercial purposes or for personal financial gain or benefit. The University of Alabama is not responsible for any liability resulting from any such activities prior to their discovery and appropriate remedy.
UA Logos, Watermarks, and Web Guidelines
UA’s Strategic Communications office provides guidelines and recommendations to ensure your site projects the appropriate UA image. Visit their site at http://strategiccommunications.ua.edu/.

ADA Compliance
All websites should comply with the Americans with Disabilities Act. What that means for you?
If you use good organization methods when constructing your website, chances are the site will be accessible.

- Titles – only use the title element for true titles. If you want text to be larger and bold, then use the appropriate methods in the toolbar (increase font size with the + key, use the B icon for bold).
- Alignment – Use the left, center, or right alignment rather than adding in extra spaces or tabs.
- PDF files uploaded – make sure that all PDFs have been run through the OCR feature in Adobe Acrobat or some other software. The purpose is to make sure the text appears as text and not an image. OCR will scan an image and extract the text.
- Photos- Add alt text with every photo:
  - Add a description if the photo is required for the understanding of information OR
  - Add two quotes (“ “) if the photo is decorative only.
  Do not embed text in a photo without adding the full text within the alt text. Text embedded in an image is unreadable by screen readers.
- Video – Should be captioned. If not captioned, provide a transcript. YouTube can help or UA has DocSoft to help.
- Audio –Should have a written transcript.
- Avoid Flash files. They do not translate well with screen readers.

Visit the Technology Accessibility website at http://accessibility.ua.edu to find helpful resources.
Login and Security

Use the Right Web Browser
We recommend, for best performance, using Chrome or Firefox.

Password Setting
Password security is absolutely critical, because you are responsible for the content of your site should your password be discovered or stolen. We strongly recommend including different cases of letters, numbers, symbols (%$@, etc.) while avoiding the use of dictionary words. Do not share passwords or accounts.

Computer Security
Do not leave your computer unlocked while you are away from your desk. Remember to set strong passwords for your computer, not just your people.ua.edu site. OIT offers good information about protecting your computer and selecting passwords.

- Protect your computer: [http://oit.ua.edu/security/cyber-safety/protect-your-computer](http://oit.ua.edu/security/cyber-safety/protect-your-computer)

Do not allow your web browser to save your passwords on any site. If the passwords are saved, it raises the risk of someone being able to hack into your computer and information.

For more information, visit OIT’s Cyber Safety page at [http://oit.ua.edu/security/cyber-safety](http://oit.ua.edu/security/cyber-safety).

Public URL
Every site must also have an address (like www.ua.edu for example) so that your visitors can find it. Your site has been predetermined as follows: www.Bama-user-id.people.ua.edu – ex. www.jsmith.people.ua.edu. This is the address your visitors will use to access the site.

Editors URL
To edit the site, go to [http://uofa.weeblycloud.com/portal](http://uofa.weeblycloud.com/portal)
A Beginner’s Guide – The Basic Steps

Elements are the building blocks of a site. All of your text, pictures, videos and other great content (aside from a few exceptions like header images, which we’ll cover later) are added via elements. Let’s take a look at some of these elements to get the hang of how they work.

Adding Text

Adding an element to a site is as simple as clicking on that element and dragging it to the content area of a page.
The text element is exactly what it sounds like: an element for writing text. Click inside the element to start writing.

You can write a word, a sentence, or multiple paragraphs in a single element.

As you write, take note of the gray toolbar at the top of the element. This is the text toolbar and it allows basic changes to the formatting of your text. It works much like any other such toolbar normally works: select the text you want to change and click the appropriate button to make that change.

From left to right, you can bold your text, italicize it, underline it, make it bigger, make it smaller, change the color, create a link, adjust the alignment of all text within the element, create bulleted and numbered lists, and remove formatting.

You may notice that one thing you cannot do is change the font family to a different style. That particular setting is controlled elsewhere by the site administrator in the Faculty Resource Center.

To add more text to the page we could continue writing in this same element, drag on another paragraph element, or use one of the other text elements:

- Title: Used for adding titles to a page.
- Text: A paragraph element.

Both of these elements use the same text editing toolbar we examined.

Using Titles and Text elements properly is VERY important for accessibility reasons. Within People.ua.edu, the "Title" element is used for headings. Screen Reader users skim the page to get an overall impression of a page's content and can jump from heading to heading. Users can hear an outline of the page's main ideas, then backtrack to read the parts they are most interested in. The main drawback to this technique is that too many pages lack titles. **Without headings, this method of skimming through content is completely useless.**

Authors should organize content with headings (titles). To the extent possible, the headings should represent an accurate outline of the content.
Do not use text formatting, such as font size or bolding of text to give the visual appearance of headings - use actual titles for all content headings. Assistive technologies and other browsers rely upon the literal markup of the page to determine structure. Items that are bolded or display in a bigger font are not interpreted to be structural elements.

Likewise, do not use titles to achieve visual results only. For instance, if you want to highlight or emphasize an element within your content that is not a heading, do not use the title element to achieve the visual appearance you want. Instead, change the text by making it bold, increasing the size slightly, or italicize it.
Adding Pictures
Adding pictures to your site works in much the same way as adding text: by dragging an image element to a page.

Click the Upload Image box to add a picture.

This opens a dialog box presenting several ways to add a photo. The two key options are to either upload (or drag) an image from your own computer or to search through the Weebly stock photo database.
Let's focus on the option to upload a photo from your own computer. The easiest way to approach this is to drag the picture you want to use from your desktop into the box that quite helpfully says "drag photo here." You can also click the green "Upload a photo" button if it isn't convenient to drag the image over.

The size of a picture will vary after upload, but it will usually show as wide as the entire site.
You can adjust the size of the image by clicking and dragging the little box that appears in the lower right corner of the image.

Clicking on the photo also opens up a settings dialog box to make further changes.

Some notable controls:

- **Lightbox:** If turned on, any visitor who clicks the image will be shown a larger version.
- **Spacing:** Makes minor adjustments to the amount of white space around the picture.
- **Caption:** Lets you add a basic text caption under the picture. Do not confuse this with ALT text.
- **Advanced:** Allows you to adjust (or turn off / on) the border around the picture **AND add alt text**.
- **Link:** This option turns the image into a link. Links are covered later in this guide.
The "Edit Image" button opens up a simple image editor.

This editor provides some basic options for adding filters, adjusting basic settings and focus, adding text, and cropping.

As an example of how these tools work, let's crop this picture a bit.
The Crop option places a box over the top of the picture. The Crop option places a box over the top of the picture. You can click on the bubble in the top-left corner to adjust the box manually, or pick from a set of predefined aspect ratios.

Once you've made changes click the arrow in the bottom left corner. If you don't like the changes you can click Crop again to readjust or click the grey Cancel button to drop out of the editor. We've cropped the example image down to more of a square; we'll keep this change and click the Save button in the upper right.

And now the changes to the image are saved.
Alternative Text (Alt Text)

Alternative text provides a textual alternative to non-text content in Web pages. It is especially helpful for people who are blind and rely on a screen reader to have the content of the Website read to them. Alternative text is also used by search engines such as Google to index your website.

Every image must have an alt attribute. While it only takes a few minutes (sometimes only a few seconds) to add Alt text, it is a very important topic with no straightforward rules.

Enter Alt Text on an image using the Advanced menu as shown below.

Alternative text serves several functions:

- It is read by screen readers in place of images allowing the content and function of the image to be accessible to those with visual or certain cognitive disabilities.
- It is displayed in place of the image in browsers if the image file is not loaded or when the user has chosen not to view images.
- It provides a semantic meaning and description to images which can be read by search engines or be used to later determine the content of the image from page context alone.

The key principle is that computers and screen readers cannot analyze an image and determine what the image presents. As developers, text must be provided to the user which presents the CONTENT and FUNCTION of the images within your web content.

Alternative text can be presented in two ways:

- Within the alt attribute of the img element.
- Within the context or surroundings of the image itself.

This means that the alt attribute (sometimes called the alt tag, though technically this is incorrect) is not the only mechanism for providing the content and function of the image. This information can also be provided in text adjacent to the image or within the page containing the image. In some cases where the equivalent cannot be presented succinctly, a link that references a separate page that contains the longer description can be provided.

Decorative images do not present important content, are used for layout or non-informative purposes, and do not appear within a link. In almost all cases, spacer and decorative images should have null alt text (alt="").

Please visit the link below to see examples and learn more about how to use Alt text so it is beneficial; not annoying! Alt Text Techniques - http://webaim.org/techniques/alttext/
Free Stock Photography
Awesome photos can make the difference between a site that's just a-ok and a site that is absolutely marvelous. If you're a photographer or have a friend who is a photographer or know a guy who knows a guy who can get you some sweet pictures, you're probably already set. But what if this doesn't describe you?

That's where Weebly's stock photo library comes in.

When you add a picture to your site using the basic Image element, you'll notice that one of the "Select Image" options provided is called Search. That Search button enables you to search for stock photography.

Search for whatever you like, and you'll see results matching the topic of your search. These photos are public domain images from Flickr.

There are plenty of excellent photos in the free database of images. Just keep in mind that these free images can ONLY be used on your website and that a small note will be made in your footer that references the photographer who took the photo.

If you're not sure which image(s) you want to choose as you go through them, there's no need to make a selection right this minute. You can mark any of the photos as favorites, which will sort them to your Favorites section from where you can choose the ones you want to use at any point in the future.
Columns

Columns can be easily created! Simply drag elements next to each other right on the page. Doing so creates two or three or four or however many columns you need.

Column widths snap to a grid

Adjust the width of a column by dragging the blue line that divides two columns. To help keep column widths consistent between pages, a grid system makes all columns snap in place. If you want to break free of this grid, just hold "Shift" while you drag the column divider line and you can drag it wherever you like.

Change the spacing between the columns by clicking on the column line.

The divider between the columns doesn't show up on the published site so none of your visitors will see that.
**Move and Copy Columns**
Simply click on one of the divider lines in a set of columns and the entire column becomes framed as a single element. The move / copy controls appear in the top left corner.

![Move and Copy Columns](image)

**Delete a Block of Columns**
You can easily delete an entire block of columns with all the elements inside it. Just as you did for moving and copying columns above, simply click on one of the divider lines in a set of columns and the entire column becomes framed as a single element. Now look on the upper-right hand side of the frame. You will see a small X. Click it to delete the column set.
Sections

NOTE: Sections are ONLY available with themes 4, 5, and 6.

The Section element gives you the ability to create engaging pages that will delight your visitors. You can drag other elements into sections, customize the background, and change the height and position on the page.

Drag the Section element from the Build tab onto your page. The section will fill the full width of the page where you place it, so choose a spot above or below other elements on the page. If you’re using a Splash page type, you won’t be able to add a section as this style of page is designed to display a limited amount of content with a single background image.

Next, you’ll want to add content to your section. Use the pre-made, customizable layouts to quickly start building great-looking sections.
Click on any one of the layout styles to see a preview of how it will appear on your page. If you like what you see, go ahead and save. You can then rearrange, add or remove any of the elements in the layout and customize them with your own content.

Don’t see anything you like in the section layouts? No problem - you can add elements manually, too! Just click outside of the layout panel to cancel and start dragging in the elements you want.

Each section on a page can have its own unique background color or image, and you can even add a video background. Click on the section and then on Edit Background.

For image and video backgrounds, you can upload your own or choose one from our built-in galleries. Background colors can be selected using the Hue slider or by entering the specific hex code for the color you want.
Want to make a section taller or shorter? Click on it and drag the blue bar at the bottom up or down to adjust the height, which will be displayed in pixels as you move the bar. If the tool tip says “Auto”, that means the section can’t be made any shorter, so you’ll need to remove some elements first.

You can also change the vertical alignment of all elements in a section by clicking on Edit Background, and then Advanced. Elements can be aligned to the top, middle, or bottom of a section.

Need to move or copy a section to another page? Click on the section and then on Move. You can move a section up or down in position on the same page, move it from one page to another, or copy it to a different page or to the same page.
Customize Your Backgrounds
NOTE: Background Customization is ONLY available with themes 4, 5, and 6.

Customizing the backgrounds on your pages is a simple way to add personal flair and make your site stand out. You can add a different background to each section and header on your site, so your creative options are practically unlimited.

Backgrounds fill the entire width of the page and can be an image, a video, or a solid color. You can use your own files or choose from galleries of optimized, high-quality media. Image and video backgrounds can be further customized with scrolling effects.

We’ll look at how to use each type of background and provide some tips to help you make the most of your images and videos.

Video Background
A video background will add dynamic visual appeal and make your site more engaging for visitors. A gallery of videos is provided that are optimized and ready to use on your site, but you can use your own as well.

If you’re uploading your own video, be sure that it’s less than 1 GB in size and one of the following formats: MOV, MP4, M4V, WMV. You’ll want to use a good quality video that’s large enough to fill the width of your page without distortion or pixilation. Most smartphones are capable of recording videos that will work well as backgrounds, so you may already have what you need to create a great-looking video.
Click on the section you want to add a video to, and then on Edit Background. Click on Video and then Add Video. To use a video from the gallery, simply click it to set it as your background instantly. To upload your own, click Upload Video and then choose the file to upload. Your video may take some time to finish uploading and display on the page, but you can go ahead and work on other things in the editor while you wait.

Click on Edit Background again to use a different video, see a preview of how it will play, or toggle the Loop setting on or off. Scroll down to toggle the Reveal scroll effect on and off and set the vertical alignment for content in the Advanced menu.
**Image Background**

To use an image background, click Edit Background for the section you’re working with. Select Image, and click Add Image. You can choose one from the gallery by clicking on the image thumbnail and then on the select button. The images in the gallery can be filtered by theme using the menu at the upper right.

To add your own image, click Upload Image and choose the file you want from your computer.

Click on the section and then on Edit Background to bring up the settings. Here you can edit or replace the current image and choose a scrolling effect for the background.

Like videos, images will also look the best when they’re high-quality and large enough to fit comfortably across the width of your page. Again, most phones have a good built-in camera capable of taking photos that will look great on your site. Wondering exactly what size the image needs to be? There really aren’t specific dimensions for a background image, but a good rule of thumb is to choose an image roughly 2,000 pixels wide and at least 1,000 pixels high - that’s large enough to ensure your background will look good on all screen sizes and devices.

**Solid Colored Background**

A solid colored background is a great solution if you want to make a bold statement or showcase special content on your page. Click the section you want to add a color to and then click Edit Background, then select Color.
Click the Change Color button to open the Color Picker. Drag the circle in the spectrum bar to the color you want, and then drag the circle in the color gradient field below to fine tune the lightness and saturation of the color. If you already know what color you want to use, you can simply type the hex code in the field below.

What if the font colors you’ve chosen don’t stand out well against your new background color? You can select the text and change the color using the A button on the text editing tool bar. You can pick one of the preset color swatches or click the arrow below to open the color picker and customize it.
Create Pages and Arrange Navigation
Your site can have as many pages and sub-pages as needed; we place no limits whatsoever on the number of pages that can be added to a site. Creating a new page is a matter of going to the Pages tab and clicking the + (plus) sign.

You will see several options for adding pages, however, on three are applicable to UA websites:
1. Standard Page - This is the option you will use most often. Standard pages are the basis of your website.
2. Blog Page - Most sites only have one blog page.
3. External Page - This creates a link in your top navigation to an external website, such as ua.edu or your college home page.

The remaining options are not used for UA:
- Category Page and Product page are used for sites that use the Store features (as in selling things).
- The Non-clickable menu is not accessible.
For now let's focus on creating Standard Pages. Selecting the Standard Page option adds a new page to your list.

Adding more pages is a matter of clicking the + (plus) sign and choosing Standard Page again (and again). As you add (and name) each page, they'll automatically become part of the site's navigation bar.

You can re-arrange the order of the pages by clicking and dragging them up and down the Pages list. Dragging a page to the top of the list will make that page your Home. The Home page can be renamed to whatever you like.

Changing the order of pages in the list will also change the order in which they're displayed in the navigation.
You’re also able to create **subpages** of other pages. You can do this by dragging a page or pages underneath and to the right of another page. While this is possible, it does have some accessibility issues. It doesn’t mean you can’t use subpages (also called drop-down menus), but it does mean you have make accommodation for those that cannot access them. See the website for more details: [http://people.ua.edu/drop-down-menus-and-accessibility](http://people.ua.edu/drop-down-menus-and-accessibility).

These subpages appear in a drop-down menu when you scroll over the main page.
**Edit the Header Image**

Scroll over the header image and click the Edit Image button.

Now you can Select a Background from a set of high quality stock images geared toward a variety of applications (and you can sort by Category in the top right). Or you can Upload an Image of your own via the button in the bottom left. Choosing this option opens up our standard image upload box.
Once you upload or find an image, you'll be able to alter it. You can move the image up and down within the header (it will already fit to the width of the page), zoom, blur, darken or add a filter.

When you're happy with an image, select the Save button to Save it. You can use the arrow to the right of the Save button to choose whether to save the image to every page of the site, just this page, or to select only certain pages to save it to. In that way you can have different headers on different pages.
Create a Flexible Header

Flexible Headers (for Themes 4, 5, and 6 only) give you creative control over the look of your pages. You can add and remove elements, customize the background, and adjust the height of the header area.

Headers are built into each new page you add by default, but you can change the header type for any page from the Pages tab. Keep in mind that Splash pages don’t support headers as this style is meant to display a limited amount of content with a single background image. The No Header page type, as the name implies, also doesn’t include a header.

The header will have a few default elements in place when you add a new page, but you can pick a different layout by clicking on the Header Section and then on Replace Header Layout. You can preview and choose from several customizable layouts, or you can just delete the default elements and manually drag in whatever you prefer.
You can customize the background for your header with an image or solid color, and you can also add a video background. Click on the header and then on Edit Background to add a new background or modify the existing one.

Want to save your header to other pages? Click on Edit Background, then Advanced - you can then choose which pages you want to save the image to.
Blogs

Start a Blog
To create a blog, go to the Pages tab of the editor, click the + (plus) sign and select the Blog Page option.

Give the blog a name (if you want to call it something other than "Blog"), select the header type, and then click Save to start adding content.
Create a Blog Post
A new blog starts with a blank content area and a sidebar with some default content that you can easily change. To create your first post, click the New Post button at the bottom-right of the screen.

Your blog post has a title and a content area. The title should generally be short - no more than a sentence long or so. Just like the headline of a newspaper article.

Adding content to a blog post works the same way as adding content to a regular page - drag elements into the post and edit them to add content.
Once the content has been added you can tag the post using Categories - these categories will appear on your sidebar, making it easier for visitors to find posts that cover specific topics. Categories can be whatever you like and it isn't necessary to use them.

Click Post Options button to get started:

Then click the Add categories button.
When you're done, you can click the Post button in the upper right corner to publish the post to your live site (which will make it instantly available) or click the arrow next to the Post button to “Save as draft” (which will allow you to edit / publish it later).

If you save the post as a draft, it will be accessible to you through a drafts area at the bottom of the blog page from within the editor (along with any other drafts you've saved). Just click the Drafts button to edit it further and save / Publish.

Every new post you Publish will appear at the very top of the page, pushing older posts further down the page. After you've added ten posts to the page, older posts will be moved off the main page to easily accessible archive pages. You can change the number of post visible by clicking the Blog Settings button at the bottom of the screen.
The Blog Sidebar

Your blog has a fully customizable sidebar. This sidebar include three sections / elements by default and these can be deleted just like any other element.

Want more stuff in your sidebar? You can add more content by dragging elements to the sidebar. There is a "Blog Sidebar" category that is meant to be used only with the sidebar, but you're welcome to use elements from any of the categories.
Here we see a sidebar that includes three of the default sidebar elements, a Flickr badge from the "Blog Sidebar" category of elements and a Blogroll (links to other blogs) that was created using a Title and a Paragraph element.

Want less stuff in your sidebar? Hover your mouse over the element you want to get rid of, then click the X that appears. Yes, you can even delete the default fields (like Author, Archive etc).

If you absolutely hate sidebars, you can turn it off completely. Go to Settings > Blog and toggle the Blog sidebar field to OFF. Once you click save and Publish, your sidebar will be gone and your blog posts will expand into the extra space.
Manage Blog Comments
Comments are turned on by default for all of your blog posts, allowing visitors to comment on any posts you've made unless you turn comments off under your Blog Settings. These comments appear underneath each individual post in the order in which they were added.

You should reply to your comments using the same comment feature all of your readers use.

Additionally, if you (or any other commenter) replies directly to another comment, that comment will appear directly underneath the original comment and will be part of a thread connected to that comment. Any other replies to that comment will appear as part of that same thread.

We notify you of these comments via the email address associated with your account (you can change this to a different address for the blog under settings). The comments can be read directly on your site or under the Blog Comments area for the blog in your account.
How can you access this Blog Comment section for the site in your account? Go to the main page of your account, click the Comments tab.

This will bring up the comment area. You can read and delete comments for all the blogs on a site here. And if you turned on comment moderation (comments are not moderated unless you turn this on) via the Blog Settings, you'll be able to approve the comments from here.
Use Facebook Comments on Your Blog

Everyone’s got an opinion, and they love to share it (especially via the ‘net). To broaden the options available for you to allow others to share their comments on your own blog posts, you now have the ability to quickly turn on the Facebook social plugin for your blog comments.

To set up your Facebook comments either go to the Blog Settings button at the bottom of your blog or go to the Settings tab and choose Blog.

Now, scroll down to the Comments section and pick “Facebook” from the Commenting System drop down menu.

Once you’ve made this selection, you’ll need to enter the Facebook URL for either your personal page or fan page so that you can moderate your comments.
If you're not sure what this URL is, just go to your Facebook page and copy everything that follows the "facebook.com" portion of the address.

Save your changes, Publish your site, and you're all done. Your blog is now using Facebook for comments!

And when anyone comments on your blog post they can immediately post their comment on their own Facebook account or Fan Page, which will lead their followers back to your site.

Maybe you don’t want any comments on your blog posts, no problem. In the Blog Settings, switch Comment visibility from Show to Hide and save. Any posts after you make that change will no longer show comments.
Use Disqus Comments on Your Blog
To set up your Disqus comments either go to the Blog Settings button at the bottom of your blog or go to the Settings tab and choose Blog.

Now, scroll down to the Comments section and pick “Disqus” from the Commenting System drop down menu.

All you need in order to get things working is a "Disqus Shortname" for your blog. This is created through your Disqus.com account via the "Add Disqus To Site" option found in your settings.

On this page, you'll see an option to Choose Your Unique Disqus URL. This is the same as the "shortname" we're looking for in your settings. You can enter whatever you want here, it won't impact your site in any way.
Once you’ve created this URL / Sitename, click the Finish Registration button. This opens up a page called "Choose Your Platform", but you can ignore this page since Weebly -- unlike the other services shown on this page -- takes care of all the setup work automatically. You simply need to take the shortname you created above and paste it into the short name field in your Weebly Blog Settings.
Schedule a Blog Post
Have you ever wanted to write a blog post, then schedule it to publish at a specific time? What was once a fantastical dream is now an unbelievable reality!

While editing, you’ll see a box on the lower left side of the screen called Post Options.
Click that box to expand the Post Options.

The first option you’ll see is Publish. This is set to “Immediately” by default. Select “Scheduled Time” if you want this post to go out at a specific time in the future.
Now, fill in the date and time.

With this done, you should notice that the Publish button in the upper right of the screen now says Schedule. Click that button and your post will be immediately scheduled to go out at the date and time you selected.

If you want to edit the post (or change the schedule time) before it goes out, you'll be able to access it via the Schedule button that will now appear at the bottom editor when you're working on your blog.

Please note that you currently are unable to publish something to a past date, as time travel is still being beta tested.
Forms and Surveys
The Form element allows you to create surveys, contact forms, and more. Fields such as checkboxes, drop-down menus, and file uploaders can be integrated into your forms very easily to allow you to collect whatever information you would like from your visitors. We’ll start by creating a simple contact form.

Create a Basic Contact Form
A contact form provides visitors to your site an easy way to reach out to you. You can ask a visitor for something as simple as their name and email address, or setup a full-on survey to ask them any number of questions. You can create as many forms as you like, either way.

Get started by dragging the Contact Form element to a page.

The form starts with three default fields and a title; the purpose of each default field (Name, Email, and Comment) is fairly self-explanatory.

These fields are set as required (meaning the recipient must enter something in the field to submit the form) by default. But this is easy to change just by clicking on a field and using the toolbar to make adjustments.
A number of settings can be altered for each field; these settings can be accessed by clicking on the field to open its toolbox. You can also delete a field by clicking the "x" that appears in the upper right of the field.

You can also add new fields to the form by dragging them on just like any other element. There are preset fields for Name, Email Address, Postal Address and Phone Number.

And generic Short and Large Text Box Fields (allowing you to create a field asking for any info you want), Options Buttons, Dropdown Boxes and Checkboxes to create survey style questions, and a File Upload field that allows the person filling out the form to send you a file of any kind.

Before completing the form, you’ll also want to give the form a name (for your own reference) and determine to which email address (or addresses) you want form submissions to be sent. You can enter more than one address by separating them with commas.
You'll also want to decide whether you want to display confirmation text directly on the same page when the form is submitted, or if you'd rather redirect visitors to another page on your site after the form is submitted.

Note that you can find these settings by using the Form Options button at the top of the form.

Replies to your form will go to the email addresses entered under Form Options and are also archived to a Form Entries section of your account. Form Entries can be accessed under Form Entries tab on the main dashboard of your site.
If you have more than one form connected to your site, then you can flip through the different forms using the Form Entries drop-down at the top of the page.
Contact Form Submissions
When a contact form is submitted, the information the visitor entered in that form is sent to two places:

1. The address (or addresses) you connected to the form during setup.
2. The Form Entries section of your account.

If you don't see the submissions in your email inbox, check your Spam or Junk Mail folders in case the messages are being routed there. If you see the messages in your spam folder, mark them as "Not Spam" using whatever option your email provider gives you. The more of these you mark as "Not Spam" the less likely they'll be to show up in your spam folder.

If you don't see them there, make sure you have the correct address assigned to your form. To do so, click on the Form Options button connected to the form in the editor (you'll need to click the form to bring this up).

Then make sure the email is entered correctly in the submissions "Email to:" field. If it isn't, re-enter it and Publish the change to your site.

You can even enter multiple addresses if you want. Just separate each address with a comma.
Delivering form emails to the inbox can be tricky and there are some situations where the emails may be completely blocked. If you cannot find the messages in your Inbox or your Spam folders and you believe the messages really aren't coming through, the best bet is to switch to another address completely (preferably at a provider like Gmail, Yahoo or Hotmail).

We're constantly fighting to keep our contact form email delivery high, but we can't guarantee the form messages will be delivered to every address. That just isn't possible. That's why we also give you the option to view form messages directly in your account. To access any messages that have been sent to you via a form, click on the Form Entries tab on the main page of your account dashboard.

This will bring up all the messages that have been sent to you through any of the forms on this site. You can even export all these messages to a spreadsheet using the Export Data link.
Video, Audio and Other Content

Upload Video
The Video Element allows you to upload HD quality videos (up to 1 GB per video) directly to your site, and display that video in a professional, unbranded player.

The Video Element is available under the "Multimedia" category of elements. To use it, click and drag it to your desired location on a page.

Then simply click the player and a dialog box will open from where you can select a video from your computer (if a box does not open, then click the blue Replace Video button to open it). Weebly supports M4V, MPG, MOV, WMV and most other standard video formats.

Depending on the size of your video and the speed of your internet connection, it may take up to 20 minutes to upload your video. You will see a status message on your screen (in the lower right corner) showing the upload progress. Just kick back and relax while the video uploads.

Once the video is uploaded, it gets encoded. The element itself will display the amount of time remaining in the encoding process. While the video encodes you can continue to work on other pages and content for your site (no need to kick back and relax during encoding), and when you come back later the video will be encoded and waiting for you.
Once the encoding process is complete you'll be all set and your video is ready to watch. You can upload an unlimited number of videos to your site. The only limit is that no single video can be larger than 1 GB by itself. Which means you can't upload any 1.5 GB videos to your site, but can upload as many 950 MB videos as you want.

You can alter the size of the video player (among several presets) using the blue toolbar that pops up when you click on the element.

Something to remember: if you're using Windows Movie Maker or iMovie, the files created when you use the Save option in these programs are not video files. They are editable files that are meant to be used with each program. Be sure to Export your final video from either program to ensure you have a video and not an unusable document file. To Export a video from iMovie go to File > Export. To Export using WMM go to Publish Movie > Export to File.

Run into other problems uploading a video? http://kb.weebly.com/video-troubleshoot.html
Using the Audio Player
The audio player allows you to easily add music, podcasts, or other audio files directly to your website.

The Audio Player element is available under the "Multimedia" category of elements. Drag it to a page to get started.

After adding it to a page, click anywhere in the element to open up the Audio Toolbar. Then click Upload Audio to select an Audio file to upload and use the Track Title / Artist fields add a Track Title and Artist to the player.

Keep in mind that our audio player currently only accepts audio files that are specifically in MP3 format. If your audio is in another format, you'll need to convert it or else it won't work. Go here to see how to convert an audio file to MP3 using iTunes, http://support.apple.com/kb/HT1550?viewlocale=en_US.

The audio file may take a few minutes to upload. Once the upload is complete, the player will expand to display the title of the audio and basic playback controls. You should now be able to play the file without any problems. The player only uses HTML and will work perfectly on all computers, iPads, iPhones, Android phones, and other mobile devices.
The YouTube Video Element
The YouTube Video element allows you to share videos from - you guessed it - YouTube. This element can be found within Multimedia, all the way over on the far right of the element bar. Drag this element to a page to get started.

Then click anywhere in the element to bring up the Toolbar. You need to enter the link to the YouTube video in the provided field.

Once you add the link, the video should show up on your page in less than a minute. You can determine the size of the video player using the Advanced option in the YouTube element's toolbox.
Embed Video and Audio to Your Site
You can add multimedia content from Vimeo.com, Blip.tv, Ustream.com (and many other providers) using our Embed Code element.

Then get the embed code for whatever you're looking to add to the site. This can usually be accessed via an embed or share button found on or near the content you're looking to share.

Here we see an example of embeddable code connected to a video that is hosted on Vimeo.com.
Once you have the embed code, click the Edit Custom HTML button to paste it in place.

When you click off of the element, your content should appear (it may take a few seconds depending on the size). All done!

Note that there are a few situations where the content you've embedded won't show up on your site until you Publish the changes. So if you don't see your video, form or what have you in the editor, try Publishing to see if it shows on the live site.
The Block Quote Element
As you might guess, this element allows for the creation of block quotes. Block quotes are defined by Wikipedia like so:

A *block quotation* (also known as a *long quotation* or *extract*) is a quotation in a written document that is set off from the main text as a paragraph, or *block* of text, and typically distinguished visually using indentation and a different typeface or smaller size quotation. (This is in contrast to a setting it off with quotation marks in a *run-in quote.*) *Block quotations* are used for the long quotation. *The Chicago Manual of Style* recommends using a block quotation when extracted text is 100 words or more, or at least eight lines.

Oh hey, that's a block quote right there. Essentially you should use a block quote whenever you'd like to have a block of text stand out from the rest of the text both above and beneath it, usually when quoting another person or source.

The block quote element can be found under the Basic category of elements when editing a blog post and under the More category on a regular page. Using this element is a matter of dragging it between two other elements. You can't drag it into the middle of a single paragraph element, so if you want to use it you need to break your text up into at least two elements.

Editing a block quote is just like editing any other text element; you have access to the same black toolbar and basic editing functions.

The look of a block quote is based partially on the style of the theme. Some themes have more subdued block quotes and others are a bit flamboyant. Outside of the basic changes available via the element text editor shown above there's no option to alter this look from theme to theme.
Upload PDFs, PowerPoint Slides and other Docs
You can upload and link to pretty much any kind of document (allowing site visitors to download it). You also have the option to embed a document so it is directly visible on a page. Here's how to do both.

Link to a Document (or Other File)
You can create a link to a document either by highlighting the text you want to link or clicking on an image, then selecting the appropriate link option for either.

If you're linking text, it'll look like this:

![If you're linking text, it'll look like this:]

If you're linking an image, it'll look like this:

![If you're linking an image, it'll look like this:]

Either option will open a link dialog box from where you'll need to select the File tab on the left and then click the Upload a File button.
And then select the file you want to upload from your computer.

Then you're all done. The link will be live and clickable on your Published site and your visitors will be able to download the file directly to their own computers.

*An important note about PDFs and accessibility issues:* Sometimes PDFs are nothing more than images that appear to the sighted user as text. Adobe Acrobat Pro provides an easy way for scanning such documents and converting them to text, thus making them accessible.

In Adobe Acrobat Pro XI, open the document to be converted. From the Tools menu, select “Text Recognition," then "In this file." Allow the program to scan all pages. Earlier versions of Adobe Acrobat Pro provide text recognition but it's under the Document menu.

Once completed, the document can be saved and, for the most part, will be accessible. To learn about tags and reading order to further enhance accessibility, visit the PDF Accessibility (http://Webaim.org/techniques/acrobat/) portion of WebAim.org.
Create Links / Hyperlinks
Links allow you to use text or images to link a site visitor to another page or file either on your site or on another site.

Text Links
To create a text link, first highlight the text you want to use for the link.

Then click the "chain link" icon in the text toolbar.
This will open the link dialog box, where you can select the kind of link you’d like to create. You can:

Link to a page on another site. You can even choose to have the link open in a new window (so that the visitor is not redirected from your own site when they click it) by checking the provided box.

Link to another page on your own site. Just select the page you want from the drop-down menu.

Link to a file so it can be downloaded. You can select a file from the drop-down menu or upload a new one using the blue "upload a file" link.
Link to an email address. This will cause the visitor's mail program (like Outlook or Apple Mail) to open so they can write you directly. Note that if the visitor is not using one of these programs, the link won't work and they'll just need to copy your address or use a Contact Form if you have one on the site.

When you've created your link, click Save and then Publish the site to test it. You can also click on any link in the editor to see where it leads and to change / remove it if needed.

Screen Readers and Links
There are two sections of important information about text links, URLs and screen readers found on our website. Be sure to read them carefully when creating your site.
**Picture Links**
To create a picture link, first click the image you want to use for the link.

Then click the Link option.
Link to a page on another site. You can even choose to have the link open in a new window (so that the visitor is not redirected from your own site when they click it) by checking the provided box.

Link to another page on your own site. Just select the page you want from the drop-down menu.

Link to a file so it can be downloaded. You can select a file from the drop-down menu or upload a new one using the blue "upload a file" link.
Link to an email address. This will cause the visitor's mail program (like Outlook or Apple Mail) to open so they can write you directly. Note that if the visitor is not using one of these programs, the link won't work and they'll just need to copy your address or use a Contact Form if you have one on the site.

**Button Element**
The button element enables you to create call-to-action buttons that link to other pages on your own site, pages on other sites, or files like PDFs and documents.

As with any other element, you can add a button to your site by dragging it to a page.

The button is essentially nothing more than a link that stands out because of its size and how it looks. You can edit the text of a button so that it says whatever you like, though buttons ideally should contain no more than five or six words.
You can link the button to a page, another website, a file or an email address via the rather appropriately named Link option. This will open up a dialog box that functions in exactly the same way as a standard text or image link.

The style of the button can be altered via four preset options. Each button has two colors and two sizes specifically designed for the specific theme you’re using.

When should you use a button instead of a regular link? When a very strong call to action is needed (like leading visitors to a page where they can purchase a product) and you want to make the link stand out more than usual.
Create Anchors (or hyperlinks to a specific location on a page)

You can create a link that directs users to a specific place (or anchor) on a page of your site. For example, if you are writing a blog post about Twitter feeds, you may want to link to your social media page; instead of having visitors scroll all the way down to the section in question, you can link to an "already scrolled" page!

You can create an anchor using text, images, or a button. In this example, we’ll look at using the button on the Landing Page layout to link directly to some text further down on the page.

(For a video explanation, see https://youtu.be/Iex5H0AW4vc)

First, decide where you want to place your anchor and drag an Embed Code element just above or next to that spot. We’ll be using the Exciting Destinations text as the anchor point, and the anchor name is destinations. You can use any word you like - it doesn’t have to be part of the text - but it is a good idea to choose an easy-to-remember name for the anchor.

Next, decide where on the page you want to link from. In this case, it’ll be the button on the Landing Page. When entering the link, you’ll need to use the “Website URL” option and type in the full link to the page followed by #youranchorname. So if your website is www.domain.com and the page you’re working on is about.html, it would look like this:

http://www.domain.com/about.html#youranchorname

Note that if you’re working on the Home page of your site like in this example, your page name will always be index.html, even if the page is called Home or News in the navigation menu.
Here’s how it looks inside the editor for our example site:

Don’t forget to leave the “New Window” option unchecked - otherwise, the anchor link will open in a new page instead of jumping down to the right spot on the same page. When you’re done, publish your site and check out your fine handiwork.
Site Title / Logo
Every site has a Title by default (you're asked to provide a Title of some kind when you first create the site) and this can be changed at any time. You have the option to simply alter the text or upload an image logo. Let's look at both options. * All University of Alabama sites must contain the UA logo within the header.

Step 1: Edit or add the site title text
- Hover over the text and click Edit. The image editor will appear.
- To edit text, click inside the text box. The text will disappear and you can now type the appropriate title.
- To add text, click the text icon.

- The text box appears with red font. Click in the box and type the text you would like to appear in your site title.

- Change the size of the text box by dragging the arrow at the top right of the text box.
• Change font size with the size icon. Just drag the bar up or down until the font is a size you like.

• Change the font color by clicking on the red icon. We cannot type in an exact color number, so do your best to match the crimson, black, or white.
• Click the Font icon to change the font style. There are only four to choose from.

When you’ve made all the changes needed, click Save in the upper-right hand corner.

**Change the size of both the logo and the text**
• Hover over the title area again and you should see a small blue box in the lower right-hand corner. Click and drag the box in and out to change size of both the logo and the text.

If you encounter any problems or special situations where there is not enough room for your text or part of it gets cut off, please call our office and we will help resolve the issue.
Multiple Headers
You don't have to use the same header image on every page of the site. You can use one header for the Home, another header for your Contact page and another for several other pages. How do you do that?

When you go to save a header you've created on a certain page, click the arrow next to the Save button to pull up different options. You can save this header to all the pages of your site, to only the page you've been working on or to pages that you select.

If you go with the "Only selected pages" option, you'll see a dialog box where you can select the pages to which you want to save this header.

All you have to do is select the pages you want and click Save. The exact header you've created will then show up on each of those pages.
Create an Image Slideshow

Our slideshow element (available under the "Multimedia" category of elements) enables you to show off your photos with style.

To add a slideshow, drag the element to a page on your site.

This will open the "Choose a Slideshow Style" dialog box where you can select which style of slideshow you want. This can always be changed later (we even provide more options later), so don't spend too much time worrying about which one you want. Let's select Thumbnails on Bottom for this example.

You'll now be prompted to upload photos. Hit the big Upload Photos button or just drag some photos into the box to get started.
Then select the photos you want to upload. You can always delete photos / upload more later.
Depending on how many photos you selected, it may take them a few minutes to upload. Once they're done uploading you'll see them all on the photo management screen.

You can drag photos to re-order them, click the chain link icon to create hyperlinks, the "bubble" icon to add a caption, the “T” to add alt text (REQUIRED) or the trash can to delete an image.
When you're ready to move on, click Save and you'll see the slideshow as part of the page.

Click on the slideshow to open its toolbox and make changes.

- Use the Add / Edit Photos button to bring up the Manage Photos dialog box we saw earlier.
- Use Transition Style to switch between five different photo transitions.
- Use Navigation to select whether you want to use Thumbnails, Numbers or no navigation at all.
- Use Speed to determine how fast the slideshow should play.
- Use Spacing to tweak the amount of space around the image.
- Use Caption Location to determine if text captions should appear at the top or bottom of each image.
- And with the Advanced option, set Autoplay to On or Off (it’s on by default) and determine if you want the slideshow to always play in order or start from a random point every time the show is loaded.

Note that the slideshow will automatically expand to the width of the page or column in which you've placed it. Experiment with the Spacer Element on either side of the slideshow to reduce the overall size.
Upload a Gallery of Images
The gallery element enables you to upload photos in bulk, which are arranged in a click-to-see-a-larger-version grid format that you can control.

Drag the Photo Gallery element (found under Multimedia) to a page to get started.

Then click the Upload Images button that appears in the element.

And either drag images into the box or click the big green Upload Photos button.
This will let you select images from your computer to upload. You can select multiple images by holding the CTRL key on a PC or the Command key on a Mac. If you have trouble uploading images, we’d recommend limiting the number of images you upload to no more than 25 at a time. You can always add more later.

Give the photos a few minutes to upload and then you’ll see your gallery on the page.

Each image in the gallery automatically links to a larger version of the image. You can also link an image elsewhere (another site or page) if you like, or add a caption that will appear on the enlarged version of an image and as a caption, and add Alt Text. It is VERY IMPORTANT that you add Alt text to each image uploaded, or add the double quotes (“”) to indicate a decorative item. Click on the individual images to see these options.
Click on thumbnails and drag them around to rearrange images within the gallery. The gallery's toolbox enables you to make additional changes.

- Add Images (there's no limit, but we recommend uploading no more than 200 images to one gallery).
- Determine the number of columns you want. The default is 3, but you can choose from 2 to 6.
- Select the amount of Spacing to place between each image.
- Adjust the captions settings. You can choose to show captions either as full or partial overlays on the thumbnails and select if the overlays should show all the time or only on hover.
- With Advanced, choose if you want a border around each thumbnail or not. And select if you want to crop the thumbnails to either squares or rectangles. This cropping has no impact on the enlarged images. It only changes the look of the thumbnails to make the gallery look more uniform.
Social Media Icons (Facebook, Twitter, Pinterest, Google+)

Each theme includes social media buttons that are designed specifically for that theme. These buttons appear in the upper right of the theme and can also be added anywhere else on the site by using the Social Icons element found under the More category of elements. They can be used to link to a Facebook fan page or profile, a Twitter feed, Google+, Pinterest, and many other services.

You can also drag social media icons to various pages and sections of your site using the Social Icons element under the More category.
Click the Manage Icons button to access the icons. Click on an icon, then either type or copy / paste a link to the appropriate page on Facebook, Twitter, etc.

And that’s all you need to do. These icons provide an easy way for site visitors to access your social media profiles and pages from any page of your site.

**Add Widgets and Other Content by Embedding Code**

**Embed Code Element**
You can add outside content (like embeddable video, audio, advertisements and forms) to your site using our Embed Code element.

Then get the embed code for whatever you’re looking to add to the site. This can usually be accessed via an embed or share button found on or near the content you’re looking to share.
Here we see an example of embeddable code connected to a video that is hosted on Vimeo.com.

![Embed Code Example](image)

Once you have the embed code, click inside the Embed Code element to paste it in place.
When you click off of the element, your content should show up there. All done!

Note that there are a few situations where the content you've embedded won't show up on your site until you Publish the changes. So if you don't see your video, form or what have you in the editor, try Publishing to see if it shows on the live site.
Embed a Google Calendar

Google Calendar is an easy, robust and free way to add a calendar of events to your site. You manage your events directly through Google's interface and the changes are automatically added to your calendar. You will need to sign up for a Google Calendar account, if you don't already have one.

Once you get up and running with the calendar (adding events, what-nots and what-have-yous), you can add it to your site with these steps.

In the calendar list on the left, click the three stacked dots next to the appropriate calendar (you can create more than one) and select the Settings and sharing option.
Go to the Access permissions section and check the box to "Make available to public."

Scroll down to the “Integrate calendar” section, locate the “Embed code” section and copy the code.

Highlight and copy the provided embed code. This is what you'll use to add the calendar to your site. Note that, while you're here, you can also use the "Customize" link below the code to make changes to the look and size of the calendar.
Back in the website editor, drag the Embed Code element to a page.

Paste the calendar embed code into the element

Click out of the element to see your calendar and then click the Publish button. Your calendar will now appear on your live site.
Add your Twitter Feed / Badge to a Site
Twitter provides an easy to use widget generator so you can share all your recent tweets with visitors to your site. To find out all the details for setting it up, visit https://hc.weebly.com/hc/en-us/articles/200513837-Add-Twitter-Feed-Badge

Add a Facebook Like (Share) Button to Your site
Adding a Facebook Like button to your site is a great way to let visitors share your site with their friends. To find out how, visit https://hc.weebly.com/hc/en-us/articles/202081836-Add-a-Facebook-Like-Button-to-Your-Site
Add a Map to Your Site

If you have an office that students or others can visit, it’s helpful to include a map to that location on your site. Weebly has a built-in Google Maps element that helps you do just that. For a video tutorial, visit http://hc.weebly.com/hc/en-us/articles/201995168-Add-a-Map-to-Your-Site

Start by dragging the Maps element to a page on your site. It’s under the Basic category of elements.

The map displays a small part of San Francisco (home of Weebly!) by default. Click on your map to open up the toolbox. You can make a number of changes from here.
The most important thing to change is the address. Enter your own address as Street Address, City, Country, like so:

This will update the map to the address you’ve entered as soon as you click out of the toolbox.

If you place a map inside a column, it will automatically adjust to the width of the column you place it in. This can be useful for writing directions directly next to the map.

And you can adjust the height of the map using the Width & Height option in the toolbox.

If you feel at all limited by Weebly's built-in Maps element, you're also more than welcome to embed a map directly from maps.google.com (or a similar mapping tool). Create the map in Google and then click the "Link" option in the upper left of the map.
Copy the code they provide you from the "Paste HTML to embed in website" field.

Then paste this code to your site using Weebly's Embed Code Element. Your map will show up as soon as you click out of the element.
Stats Dashboard
You can view Stats for your site via the Stats button on the main page of your account.

You can see Pageviews and Unique Visitors from the past 30 days. You can also see the most visited pages, search terms that were used to find the site and the sites which referred the most traffic to the site.

What do all these stats mean?

**Pageviews:** The number of pages visitors viewed on a given day. One visitor may visit three, ten, twenty, however many pages.

**Unique Visitors:** The number of individual visitors who came to the site. The unique visitors number should always be smaller than the pageviews number simply because one person can visit multiple pages and thereby generate a number of different pageviews.

**Top Pages:** The pages with the most visits. The page called "/" is the home page and it should get the most visits usually.

**Search Terms:** This shows which search terms visitors have entered in Google, Bing and Yahoo to find your site. The more search terms you see, the better ranked your site likely is in on the search engines.

**Referring Sites:** If a visitor clicked a link on another site to reach your site then they have been "referred" to your own site by this other site. The more in-bound links you have pointing to your site, the better your search rank will likely end up being.
The Basics of SEO

Every website has an address that can be used by anyone who wants to visit that site. But how do people who don’t know the address of your site find you? Search Engines! Most people use Google to look for sites, and a smaller number of people use Yahoo or Bing. So you want to get your site listed on these search engines so that your site can be found by the wide audience of potential visitors.

So what are the first things you should do to make your site easy to find on search engines?

Use the SEO Tools in Your Account

Every Weebly site has a place for you to enter Keywords and a Description for your site. These can be found under Settings > SEO.

Both of these fields help search engines to categorize your site. And the Description is what will actually be displayed as the description for your site in your search engine listings.

The Description should be two to three sentences long and provide a fairly detailed description of what your site is about. Are you a florist in Denver? Then write something like:

Flowers and Such is a professional florist in Denver, CO with 25 years’ experience making birthdays a little brighter and anniversaries a little rosier. We have roses, lilies, orchids, tulips and every other flower under the sun.

That example Description lets visitors know exactly what the business is about, where it's located (which helps locals see this in their searches), lists some flowers people may be searching for and shows a little personality to boot.

The Keywords should be fairly targeted and also be the kind of words you use on your site. If your Keywords don't match your site content then they are practically useless. The imaginary florist we've written about above
might want a list of Keywords like Flowers, Florist, Denver, Colorado, Birthdays, Anniversaries, Weddings, Apologize, Roses, Lilies, Orchids, Tulips. You may want to use around 20 or 30 words here that match your content and the types of searches people may do to find that content.

Note that Keywords are ultimately only helpful with search engines if they are words you actually use throughout your site (especially in Title areas). Otherwise Google (and other search engines) will just think you're trying to game the system by using Keywords that are irrelevant to your site and will just ignore them. Each page of your site also has a place for Keywords and a Description. These can be found under Pages > Advanced Settings.

These work the same way as the Site Keywords / Description except they should be specific to the content of the page to which they're connected.
How to Optimize Your Site for Search Engines (SEO)

Now that you’ve built a great site, you’ll want people to be able to easily find and visit your site. One way to do that is to simply give them the address (like www.nameofyourwebsitehere.com) so they can go there directly. But, of course, that only works for those people to whom you have a close enough connection to provide the address. Everyone else will find your site on Search Engines like Google, Bing and Yahoo. How can you optimize your site to ensure you appear as high as possible in the search engine rankings?

Start with the basics. Read our Use the SEO Tools in your Account (http://people.ua.edu/use-the-seo-tools-in-your-account.html) to learn how / why to add this information throughout the pages of your site. While you’re doing this, keep in mind that keywords are not made out of magic (this is explained further in the Keywords help article linked above). Just because you add a keyword to your site does not mean search engines are going to find you through that keyword. If life were that easy, we’d all be rich and retired to our own private islands by now.

Use page names that are relevant to search words and phrases. The name you provide to a page in people.ua.edu is the name given to that page both in the site navigation and in the address of that page on your site. Why is this important? Because if a word is in your address, it is seen as more relevant to your site by search engines. More relevant means more likely to show up in search results.

Use keyword phrases in your links. If you link from one page of your site to another, use descriptive text for the link. For example...

- This: Read our How to Create Links article (http://www.people.ua.edu/text-hyperlinks.html) to learn how to do this on your own site.
- Is better than this: Learn how to create a link by going here (http://www.people.ua.edu/text-hyperlinks.html).

Use Titles to headline content in your site (when appropriate). Search Engines see Titles (which are tagged as H2 -- don’t worry about this if you don’t know what it means) as generally more important than regular text. You can add Titles to your site via our Title element. But don’t write all your text in a Title. That will make things worse for your site. You can’t trick the search engines like this, so don’t try.

Is your site relevant only to people in a certain area? Highlight that by Creating a Google Map (http://people.ua.edu/the-maps-element.html) that shows site visitors your location and by referring to the physical location of your business throughout the site where appropriate. Writing “Visit our San Francisco showroom” is better than writing “Come see our showroom.”

Use alt-text for your photos. Add alt-text to a regular picture by clicking on it and using the Advanced Option in the toolbar. This should be used to add a short description of the image. View our Adding Pictures page (http://people.ua.edu/adding-pictures.html) to see more detail on this option.
Get other sites to link back to your site. The more sites that link to your own site (as a general rule), the more
Google trusts your site to be worthwhile. Think of other people linking back to your site as word-of-mouth that
tells not just other people to check-out your site, but tells the search engines to do the same.

There is nothing more important to your ranking than other sites linking to you, but there is no get-rich-quick
method to get links back to your site. Build interesting content and let people know it exists. Just as building a
business takes work and time and effort, building traffic to a website takes work and time and effort.

Link to your own site from any other sites you may have (like a Twitter or Facebook profile). If you have an
e-mail newsletter, archive it via your e-mail provider's site so that your own newsletter acts as another site linking
to you.

Maintain a Blog. A blog enables you to continually add content to your site. The search engines like to see new
content on your site. Read our Create a Blog article (http://people.ua.edu/create-a-blog-post.html) to learn how
to build a blog.

Make reasonable goals. If you're a photographer, you are not going to show up at the top of the search results
for the word photographer. If you're a florist, you aren't going to show up at the top of the search results for
flowers or mother's day.

But if you're a photographer in San Francisco, you can potentially get to the top of the list for San Francisco
Headshot Photographers. If you're a florist in London, you can work to get a good search ranking for Valentine's
Day Flowers, London. Focus on that. Focus on getting your site to show up in a search for your own name. Try to
geret the attention of bloggers who may write about your business.

And if you want more tips, do a Google search for SEO Tips. A lot of different people have written a lot of
different articles on this topic. This help article is meant to be a good place to start, but it certainly isn't the end-
all, be-all of SEO. It never hurts to research other sources of information.
**Google Analytics**

Google analytics provides much more information than Weebly’s Dashboard. To learn all the details about it and how to add analytics to your site, visit [https://hc.weebly.com/hc/en-us/articles/201979698-Google-Analytics](https://hc.weebly.com/hc/en-us/articles/201979698-Google-Analytics).

When you publish your website, we ask for your Gmail address so that you can have access to your site’s Analytics reports. This specifically requires a Gmail address because Analytics is a Google product.

If you don’t have a Gmail address, it’s easy enough to create one specifically for this purpose. But you probably don’t relish the thought of *another* email address to check. Luckily, there’s a way to take any mail sent to this new account and forward it to an account you use more often (like your @ua.edu address).

When you’re logged into your new Gmail account, look for the gear-shaped icon in the upper right; click that and then click “Settings.” You’ll see different headings along the top of the Settings page – look for “Forwarding and POP/IMAP.” Forwarding is the first option on this page, and all you need to do is click “Add a forwarding address” and type in the address you want to use.

You’ll then click a button to confirm the forwarding address, and a confirmation code will be sent there. Either enter this code in the Forwarding section of your Gmail settings, or simply click the link that is included in the message.

And that’s all there is to it – any messages sent to your new Gmail account will now be forwarded to the account of your choice.
Settings Tab
The Settings tab provides you with some very important options, including changing your site title, site password, and SEO settings. There ARE however, a few things you may NOT change. Be cautious and make certain you fully understand any changes you make on this tab.

General Settings

- **Site Title** – You may change the site title. It will not appear in in your site header, but will appear on the dashboard and at the top of each page tab within the browser.
- **Favicon** – The favicon is pre-set and should not be edited.
- **Site Password** – you may set a site password and apply it to one or more pages of your site.
- **Navigation** – all sites, by default, group excess pages under “More…” in the navigation bar. You may change it, if desired.
- **Archive** – once your site is published, you will be able to create an archive.
- **Site formatting** – Change the date, time zone, language if needed
- **Cookie Notification** – We recommend leaving the default settings but you may change it if you wish.
- **Un-publish** – You may unpublish your site but **PLEASE notify the people.ua.edu administrator** if you do.
### General

**Site Title**

- Workshop taking

[Show title on the top of your pages]

**Site Category**

- Online Store

[This allows us to provide suggestions and personalization]

**SSL**

- Not Enabled

**Favicon**

- [Upload][Restore]

**Site Password**

[Password protect your site]

[Your site password will automatically apply to all your pages. You can change this for individual pages in the “visibility” section of the “Pages” tab.]

**Navigation**

- [Group excess pages under “More...”]

**Archive**

[Your site must be published in order to archive it.]

**Site Formatting**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date format</td>
<td>MM/DD/YYYY</td>
</tr>
<tr>
<td>Time format</td>
<td>12 hour</td>
</tr>
<tr>
<td>Time zone</td>
<td>Central Time (US &amp; Canada) (UTC-6)</td>
</tr>
<tr>
<td>Site Language</td>
<td>English</td>
</tr>
<tr>
<td>Editor Language</td>
<td>English</td>
</tr>
</tbody>
</table>

**Cookie Notification**

- [Notify your visitors that your site uses cookies]

- [Show To: EU Visitors]

- [Cookie Policy URL: http://www.yourwebsitechoices.eu]

**Cookie Banner**

[Custom Text: You may choose to customize this text. By doing so, you assume all liabilities and risks resulting therefrom. If you customize this language, the text will only appear in the language in which it was written.]

---

**Un-publish**

The site is not currently published.
## Search Engine Optimization (SEO)

<table>
<thead>
<tr>
<th>SEO</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Site Description</td>
<td>Appears in search engine results</td>
</tr>
<tr>
<td>Meta Keywords</td>
<td>Separate each keyword with a comma</td>
</tr>
<tr>
<td>Footer Code</td>
<td></td>
</tr>
<tr>
<td>Header Code</td>
<td></td>
</tr>
<tr>
<td>Hide site from search engine</td>
<td></td>
</tr>
<tr>
<td>301 Redirects</td>
<td></td>
</tr>
</tbody>
</table>

### Site Description - The Description is what will actually be displayed as the description for your site in your search engine listings. The Description should be two to three sentences long and provide a fairly detailed description of what your site is about. Further details are discussed in the SEO Tools section of this manual.

### Meta Keywords - The Keywords should be fairly targeted and be the kind of words you use on your site. These should include your areas of expertise. Further details are discussed in the SEO Tools section of this manual.

### Footer Code and Header Code – Use this section for placing code from Google Analytics or Webmaster tools. We will set up your Google Analytics account for you, unless you prefer to provide your own. To view the reports, you will need a Gmail account; read more about this and how to forward mail to your primary account under “Google Analytics.”

### Hide site from search engine – You may choose to hide your site by checking the box.

### 301 Redirects – Use this function if you are moving your site from one URL to another. Visit [http://kb.weebly.com/301-redirects.html](http://kb.weebly.com/301-redirects.html) for complete information.
Membership
The University of Alabama has purchased the Pro plan of Weebly, not the Business plan. Therefore, not all membership features are available.

Membership: Limiting Page Visibility to Members
Every page on your site has a Visibility setting that defaults to "Public". This default setting, of course, means that any visitor to your site can see the page.

You can view and change this setting by selecting the Pages tab, selecting your page in the Pages sidebar, and clicking Visibility.

Changing this setting allows you to limit access to any page so that only registered members (or even just certain registered members) can see it.
If you set a page to only be accessible to specific Members or Groups, then you'll need to choose which Members / Groups will be able to view the page.

The Select Members button will display your entire list of members so you can select specific individuals who will be allowed access to the page. This is really only useful if you have a small number of members.

The Select Groups button gives you more control over larger numbers of people by enabling you to provide access to a group (or groups) of members you've previously created.

Once you've limited visibility in this way (and republished your site), only the members or groups you've selected will be able to access the page.
Membership: Creating Groups
Groups are the easiest way for you to manage varying levels of access to different pages/sections of your site. Create groups by going to Settings > Members and using the Add Group button.

Give your group a name.

If you already have members, you can add them to your group through the Select Members option.
Use the checkboxes to choose individual members or use the Add All Members button to do just that: add all current members of your site to the group.

At any point in this process you can click Add Group to add it to your list of Groups.

You can then edit this group later (possibly to add more members, for one example) by clicking on its name from this same list of Groups.
Membership: Inviting New Members
You can add members to your site by manually inviting them or by downloading them from a CSV file.

Enter an Email Address and their Name. If your site is published, you send an email invite that'll allow them to sign-up. If you don't send them an email invite, you'll need to provide them with the sign-up link (we'll show you where this link can be found at the end of the article).
You can also select pages you'd like them to be able to access or groups you'd like them to be part of before adding them as a member.

Finish up by clicking Add Member. They're now officially a Member of your site. But before they can log in, they'll need to follow the link that was sent them from the email invite. If you didn't send them an email invite (or they didn't receive it), you can find the Invite Link next to their name in your Members List.